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CREATING DATA VISUALIZATIONS 

 

This is your Data Source page, where you can organize your data. On the left panel, you 

can see the sheets that were in the Excel file that was uploaded. If these sheets have 

common fields, you can join them by dragging them to the center together. For our 

purposes, we just need Dataset 1 - Total Expenditure, so drag that sheet to the centre. 

But before doing this, check off the box Use Data Interpreter so that Tableau can clean 

up the workbook and make it suitable for use.  

After cleaning the data and dragging the sheet to the centre, your screen should look 

like this:  

I.CREATING A MAP OF CANADIAN HEALTH EXPENDITURE BY PROVINCE IN 2016 

Once you have uploaded your properly formatted geographic data your screen will look 

like this: 



 

 

We can also see that Expenditure and Year have been assigned as Numbers which

is  also what we want. It's important to know about this feature for future uses.  

Now, on the bottom of your screen, you should see a tab labelled Sheet 1, click this. 

Your screen should now look like this: 

Your data is now connected, and Tableau has assigned a Data type to each column. 

Click the symbols in the header of each column to make sure it’s the type you want. In 

our case, we want to make sure the Province column is assigned a geographic role. 

When we click this icon, we see that Tableau recognized the Province codes and did it 

for us!  

So now you’re in your worksheet and this is where you will build your map. On the left 

side of your screen is the Data pane. The columns of your data are listed as fields and 

assigned as Measures or Dimensions. Dimensions are usually qualitative data and 

Measures are quantitative, you can drag and drop fields in to either of these categories 

to change their assignment if needed. You can see that Tableau automatically 

generated Latitude and Longitude Measures because we’re using geographic data.  



 

 

Now, to begin creating the map, drag and drop Province into the centre of your

sheet.  Your screen should now look like this: 

 

You will see that longitude and latitude have automatically been placed into the Columns 

and Rows shelves. You now have a basic map view that can be edited as you like by 

dragging and dropping other fields into the marks.  

We are now going to drag Expenditure into Label: 



 

 

The expenditure labels should now change to look like the above image.  

 

Now, we want to edit the label properties because we know expenditure is in millions of 

dollars. To do this, we click Expenditure in the Measures tab and the drop down menu 

should appear. Click on Default Properties and Number format.  

Now, each province has the sum of their health expenditures since 1975 labelled on the 

map. But, we only want the expenditure for the year 2016, so we have to place a filter on 

the map. To do this, we will drag Year from Dimensions into the Filters box. This box 

should appear.  

Change the Range of values from 1975-2018 to 2016-2016 to just get expenditure data 

from the year 2016.  
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Next, we are going to colour our map based on the provinces. To do this, drag and drop 

Province from Dimensions to Colour in the Marks card. Make sure to change the marks 

tab to Map at this point from Automatic in the drop down menu. Each province is now 

 

This allows us to change the properties of how Expenditures appear on our map. In the 

box that appears, (2), change the Suffix to “M”, so all the expenditure values will carry an 

M as in millions at the end. We won’t use the Display Units option because our units from 

our data are displayed in millions and it will not translate to the right amount with this set 

of data. In other cases, you can use this option. Also, set the Decimal places to 1. Your 

screen should now look like this: 



 

 

coloured by region (see Image 1 below). You could also colour the map based on 

Expenditure if you chose to drag Expenditure to colour (see Image 2 below).  

(1) (2) 

 

You can also click on Colours in the Marks card to edit and choose other colour 

schemes. Just click on Edit Colours after clicking on Colours, then click the drop-down 

menu underneath Palette, and choose the one you like.  

 

 

Next, we’re going to create custom territories in our map. This may be useful to look at 

trends in certain geographic areas on the map. To do this, click on Province in 

Dimension. From the drop-down menu, choose Create, then Group (Image 1). In the box 



 

 

 

 

 

Having this Hierarchy made will now allow us to visualize expenditures based on the 

geographic regions we created.  

that opens (Image 2), you can group provinces together based on custom sub-groups.  
1) 2)  3) 

 

 

 

 

 

 

We are going to group ours based on regions in Canada. I am first going to select using 

the command key NL, NS, NT, PE to create a sub-group for Atlantic Canada (Image 2), 
click Group, then name it Atlantic Region (Image 3). I can repeat this for all regions in 

Canada. Click OK when finished to create all the groups and return to the main page. 

 

 

Now returning to the main page, I should see under Dimension a field called Province 

(group). If I drag this new field to the Marks section, it can be applied in a variety of ways 

to the map. But, I want to apply it in a way to create a map that groups expenditures 

based on these regions. So, I need to create a hierarchy of my geographic region fields. 
To do this, I will click on Province in Dimensions and select Hierarchy from the 

drop-down menu and then create Hierarchy (Image 1). From the Hierarchy dialogue box 

that appears, name the Hierarchy something, such as Mapping details (Image 2), then 

click OK. Province will now appear under Mapping details in Dimensions. Drag Province 

Group under this Hierarchy as well. Dimensions should now look something like Image 3.  

1) 2) 3) 

 



 

 

To do this, I will drag Province (group) to Colour in the Marks box. You will see the map 

will change and be coloured by the geographic regions (Image 1). Then, I will remove 

Province from the Marks box, and the expenditures for each province will sum to the 

region (Image 2): 
 1)2) 

 

 

 

Now I want to compare between expenditures by region and province, so I want to 

create a dual axis map. So, I will drag Longitude or Latitude to the Columns or Rows 

shelf, respectively, depending on what axis I want my second map to appear (Longitude 

→ Columns for besides one another, Latitude → Rows for on top of one another). For this 

example, I want the maps beside one another like so: 

Now to change the map on the left to display expenditure by province, I will click on 

Longitude Generated tab to open up a Marks for just the left province. Here, I will drag 

Province from Dimensions to Colour. The map on the left should change to show 

expenditure by province, while the right map remains the same. Your screen should look 

like this: 



 

 

 

 

 

Congrats! You now have a Dual Axis Map to compare between provinces and regions 

the healthcare expenditures of each.  

II.CREATING A LINE GRAPH OF CANADIAN HEALTH EXPENDITURE BY 

PROVINCE IN 1975-2018 

Next, we are going to create a line graph of each province’s health expenditure from 

1975-2018. We are going to continue to use the same data as in the previous example, so 

we do not have to return to the data source tab. Click on “New Worksheet” located at the 

bottom right of your screen next to Sheet 1 to add a new sheet. Your screen should now 

look like this:  



 

 

 

You will see that Tableau has summed the health expenditures from the years 1975 to 

2018 and has placed this value in the Row shelves.  

We are now going to double click on “Year” in the Dimensions field.  

 

This line graph is showing the summed health expenditures across all provinces on the 

x-axis and year on the y-axis. We can continue to edit this graph to compare health 

To begin building your line graph, double click on “Expenditures” in the Measures

field.  Your screen should now look like this:  



 

 

  

De-select “Canada” and then press “OK”. Your graph should now look like this:  

expenditure by each individual province. To do this, double click on “Province” in

the  Dimensions field.  

 

You will see that the summed health expenditure for all of Canada is still be represented 

on the map, which is denoted by the orange line. We can edit this by dragging 

“Provinces“ from the Dimensions field into the Filters box. This box should appear:  



 

 

 

Using the same data uploading method as earlier, select “Dataset 2 – Expenditure by 

Age” from the sample data and open a new sheet. 

You can change the colour schemes of the line graph similar to how we changed the 

colour on the map in the previous example. Just click on “Color” and then “Edit Colors” 

and select the palette of your choice from the drop-down menu.  

VISUALIZING THE PROPORTIONAL DISTRIBUTION OF HEALTH CARE EXPENDITURE 

AMONG AGE GROUPS IN CANADA 

This section uses a new set of data. To create a new Tableau Public workbook with the 

new data, click the “New” button under the “File” tab. 

 



 

 

 

Next, drag the “Expenditure” measure onto the undefined data column (Containing 

“Abc”) on the chart. The chart then lists the total Canadian expenditure for each age 

group. 

 

Click on the “Show Me” tab at the top right of the page to display a variety of data 

visualization techniques. If you already see the bar open, do not click on it. Then, select 

the “stacked bars” option to transform your data chart into a stacked bar graph. 

There are several methods of visualizing the proportional distribution of data in Tableau 

Public. On the first sheet, you will be creating a stacked bar graph comparing health care 

expenditures between provinces while also visualizing the distribution amongst age 

groups. On the second sheet, you will create a pie chart that visualizes the distribution of 

Canada’s total expenditure among age groups. 

On the first sheet, start off by double-clicking on the dimension “Age Group.” A chart 

should appear showing the age groups. 



 

 

 

Now to add some colour to the graph to visualize the proportions better. Drag the blue 

“Age Group” mark to the “Color” square. 

 

Now, divide the expenditure data into its provincial distributions. Do this by dragging the 

“Province” dimension into the “Columns” bar near the top of the page. 



 

 

 

You may notice that half of each bar is one colour. This is because the “Total” value for 

each province is still being included. To remove this measure, drag the “Age Group” 

dimension to “Filters” and de-select “Total” in the “General” tab. If you wish to also 

remove the large bar that represents Canada’s total expenditure from the graph, repeat 

this step with the “Province” dimension and de-select “Canada” from the list. 

 

Your stacked bar graph is now complete! If you wish to make the graph larger or smaller, 

press shift+command+B or command+B, respectively. Or you can go to the “Cell size” 

option in the “Format” tab. 



 

 

 

Just as you did so when making the stacked bars, add filters to remove data from the 

“Total” age group. You should now have a pie chart with a slice & colour representing 

each age group. 

 

Open a new sheet again to get started on your pie chart. To begin, double-click “Age 

Group” and drag in “Expenditure” the same way you did to start your stacked bar graph. 

You should again end up with a chart displaying age groups in the left column and their 

respective expenditures in the right column. This time select the “pie charts” option from 

the “Show Me” menu. 

 

When hovering over each slice, the respective age group and expenditure value should 

be displayed. Another helpful piece of information is the percent of the total expenditure 



 

 

To add labels to the pie chart, drag the information that you want labelled onto

the  “Label” box. For example, you can label the slices according to age group. 

 

 

Your pie chart should now be complete! Again, if you wish to make the chart larger or 

smaller, press shift+command+B or command+B, respectively. Or you can go to the “Cell 

size” option in the “Format” tab. 

allocated to that age group. To add this info, click the arrow on the right of one of the 

green “SUM(Expenditure)” buttons in the “Marks” box. Then hover to “Quick Table 

Calculation” and select “Percent of Total.” This both ensures that the slices of the pie are 

proportionate to their respective percent of total expenditure, and will also display this 

information when you click on a slice of the pie chart. 



 

 

 

Congrats! You can now visualize the proportional distribution of your own data! You’re 

also ready to add that data to an interactive dashboard! 


